Foundation Flash CS3 for Designers

Tom Green and David Stiller
To Robert Green, my “Number One” son and camping buddy.

—Tom Green

To the memory of Travis Swinton, educator, musician, artist, and best Chewbacca impersonator in the galaxy. I’m deeply grateful we had the chance to catch up.

—David Stiller
CONTENTS AT A GLANCE

Chapter 1: Learning the Flash CS3 Professional Interface ..................... 3
Chapter 2: Graphics in Flash CS3 ..................................................... 49
Chapter 3: Symbols and Libraries .................................................... 111
Chapter 4: ActionScript Basics ......................................................... 157
Chapter 5: Audio in Flash CS3 .......................................................... 205
Chapter 6 Text in Flash CS3 ............................................................... 239
Chapter 7: Animation in Flash CS3 .................................................... 283
Chapter 8 Video in Flash ................................................................. 339
Chapter 9: Using the Flash UI Components to Build Interfaces ................. 389
Chapter 10: CSS and Flash ................................................................. 425
Chapter 11: Dynamic Data (XML) and Flash ....................................... 451
Chapter 12: Going Mobile in Flash ..................................................... 473
Chapter 13: Optimizing Flash Movies ................................................. 505
Chapter 14: Publishing Flash Movies ................................................ 535
Index ................................................................................................ 556
Chapter 3: Symbols and Libraries

Symbol essentials .................................................. 113
Symbol types ......................................................... 115
Editing symbols ...................................................... 117
Symbols and 9-slice scaling ..................................... 118
The 9-slice “gotchas” ............................................... 122
Sharing symbols ...................................................... 124
Sharing libraries ....................................................... 125
Filters and blend modes .......................................... 129
Applying a Drop Shadow filter .................................. 130
Playing with blends ................................................ 134
Managing content on the stage .............................. 136
Aligning objects on the stage .................................... 138
Stacking order and using the Align panel .................. 140
Masks and masking ............................................... 144
A simple mask ....................................................... 144
Using text as a mask ............................................... 148
Your turn: Creating a soft mask in Flash .................. 151
Creating the cutout for the mask ............................. 152
A mask without a mask layer ................................... 153
What you’ve learned ............................................... 155
Chapter 4: ActionScript Basics .................................................. 157
The power of ActionScript ................................................... 159
The Actions panel ................................................................. 160
ActionScript vs. behaviors .................................................... 164
Everything is an object .......................................................... 164
Classes define objects ......................................................... 165
Properties ............................................................................. 166
Methods ............................................................................. 169
Events ................................................................................. 171
Syntax .................................................................................. 174
Commenting code ............................................................... 175
Dot notation ....................................................................... 177
Variables ............................................................................. 178
Data types ........................................................................... 180
Operators ............................................................................. 182
Conditional statements ....................................................... 185
Class files ............................................................................ 190
Document class .................................................................... 190
How to read the ActionScript 3.0 Language and Components Reference .................................................. 192
Search tactics ........................................................................ 193
Checking syntax .................................................................... 196
Your turn: Using ActionScript ............................................... 200
Pausing the main timeline .................................................... 201
Looping the timeline ............................................................. 202
What you’ve learned ............................................................. 203

Chapter 5: Audio in Flash CS3 .................................................. 205
Flash and the audio formats .................................................. 207
Bit depth and sample rates .................................................... 207
Flash and MP3 ..................................................................... 209
Adding audio to Flash ........................................................ 210
Using audio in Flash ............................................................ 214
Your turn: Adding sound to a button ..................................... 218
Controlling audio with ActionScript 3.0 .............................. 219
Playing a sound from the library ......................................... 219
Using a movieclip to play a sound ....................................... 220
Playing a sound from outside of Flash ................................. 222
Turning a remote sound on and off ...................................... 223
Your turn: Building an MP3 player ....................................... 224
What you’ve learned ............................................................. 237
### Chapter 6: Text in Flash CS3

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fonts and typefaces</td>
<td>241</td>
</tr>
<tr>
<td>Working with device fonts</td>
<td>243</td>
</tr>
<tr>
<td>Types of text fields</td>
<td>245</td>
</tr>
<tr>
<td>Static text</td>
<td>245</td>
</tr>
<tr>
<td>Your turn: Playing with static text</td>
<td>248</td>
</tr>
<tr>
<td>Dynamic text</td>
<td>256</td>
</tr>
<tr>
<td>Input text</td>
<td>263</td>
</tr>
<tr>
<td>HTML formatting</td>
<td>264</td>
</tr>
<tr>
<td>Hyperlinks and Flash text</td>
<td>266</td>
</tr>
<tr>
<td>Using HTML for hyperlinks</td>
<td>267</td>
</tr>
<tr>
<td>Using hyperlinks to trigger ActionScript</td>
<td>268</td>
</tr>
<tr>
<td>Embedding font outlines</td>
<td>269</td>
</tr>
<tr>
<td>Checking spelling</td>
<td>273</td>
</tr>
<tr>
<td>Your turn: A visit to the pond</td>
<td>275</td>
</tr>
<tr>
<td>Scrolling text</td>
<td>277</td>
</tr>
<tr>
<td>What you’ve learned</td>
<td>281</td>
</tr>
</tbody>
</table>

### Chapter 7: Animation in Flash CS3

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape tweening</td>
<td>285</td>
</tr>
<tr>
<td>Scaling and stretching</td>
<td>286</td>
</tr>
<tr>
<td>Shape tween modifiers</td>
<td>289</td>
</tr>
<tr>
<td>Altering shapes</td>
<td>290</td>
</tr>
<tr>
<td>Shape hints</td>
<td>293</td>
</tr>
<tr>
<td>Altering gradients</td>
<td>296</td>
</tr>
<tr>
<td>Motion tweening</td>
<td>297</td>
</tr>
<tr>
<td>Rotation</td>
<td>298</td>
</tr>
<tr>
<td>Motion tween properties</td>
<td>299</td>
</tr>
<tr>
<td>Scaling, stretching, and deforming</td>
<td>300</td>
</tr>
<tr>
<td>Easing</td>
<td>301</td>
</tr>
<tr>
<td>Custom easing</td>
<td>304</td>
</tr>
<tr>
<td>Using animation</td>
<td>310</td>
</tr>
<tr>
<td>A closer look at the Timeline panel</td>
<td>310</td>
</tr>
<tr>
<td>Onion skinning</td>
<td>311</td>
</tr>
<tr>
<td>Editing multiple frames</td>
<td>314</td>
</tr>
<tr>
<td>Combining timelines</td>
<td>318</td>
</tr>
<tr>
<td>Motion tween effects</td>
<td>322</td>
</tr>
<tr>
<td>Motion guides</td>
<td>325</td>
</tr>
<tr>
<td>Tweening a mask</td>
<td>327</td>
</tr>
<tr>
<td>Your turn: Making an animated button</td>
<td>328</td>
</tr>
<tr>
<td>An even cooler animated button</td>
<td>329</td>
</tr>
<tr>
<td>Copy motion as ActionScript 3.0</td>
<td>331</td>
</tr>
<tr>
<td>What you’ve learned</td>
<td>336</td>
</tr>
</tbody>
</table>
## Chapter 8: Video in Flash

- Video on the Web .............................................. 341
- Encoding an FLV ............................................ 342
- Playing an FLV in Flash CS3 ................................. 351
  - Using the Import Video wizard ......................... 351
  - Using the FLVPlayback component ..................... 357
  - Playing video using ActionScript ....................... 361
  - Using the FLVPlayback control components .......... 364
  - Using the FLVPlaybackCaptioning component ........ 366
    - Timed text XML for captions ......................... 366
    - Preparing and using alpha channel video .......... 369
    - Going full screen with video ......................... 371
    - When video is not video ................................. 375
    - Your turn: XML captions for video .................... 378
      - Playing with alpha channel video .................. 383
- What you’ve learned ........................................ 386

## Chapter 9: Using the Flash UI Components to Build Interfaces .... 389

- Button component .......................................... 391
  - Using the Button component ............................. 392
- Changing the Button component’s appearance ............ 396
  - Skinning ...................................................... 396
  - Styling components ........................................ 398
- CheckBox component ........................................ 401
- ColorPicker component ..................................... 402
- ComboBox component ....................................... 404
- DataGrid component ........................................ 407
- Label component .............................................. 408
- List component ................................................. 409
- NumericStepper component ................................. 411
- ProgressBar component ..................................... 412
- RadioButton component ..................................... 413
- ScrollPane component ....................................... 415
- Slider component ............................................. 416
- TextArea component ........................................ 417
- TextInput component ........................................ 418
- TileList component .......................................... 419
- UILoader component ......................................... 420
- UIScroller component ....................................... 422
- What you’ve learned ......................................... 423
## Chapter 10: CSS and Flash .................................. 425
- The power of CSS ........................................ 427
  - Element selectors vs. class selectors .................. 434
  - Custom tags ...................................... 437
  - Style inheritance .................................. 439
  - Styling hyperlinks .................................. 440
  - Embedded fonts .................................. 442
  - Loading external CSS ................................. 445
  - What you’ve learned ................................ 448

## Chapter 11: Dynamic Data (XML) and Flash ............... 451
- The power of XML ..................................... 453
  - Writing XML ..................................... 453
  - Loading an XML file ................................ 456
- E4X ..................................................... 457
  - E4X bonus round .................................. 462
  - Your turn: Using XML to build a slideshow ......... 463
  - What you’ve learned ................................ 471

## Chapter 12: Going Mobile in Flash ......................... 473
- Flash and devices .................................... 474
  - Device Central CS3 ................................ 476
  - Creating a new Flash document using Device Central ........................................ 480
  - Testing a mobile movie ............................. 484
  - Publishing a mobile movie ......................... 487
  - Constructing a mobile application ................. 489
  - Adding the gallery ................................ 494
  - “Wiring it up” with ActionScript ................. 495
  - What you’ve learned ................................ 503

## Chapter 13: Optimizing Flash Movies ....................... 505
- Flash’s “love-hate” Internet relationship ............. 506
  - This “Internet” thing ................................ 507
  - Enter the World Wide Web ......................... 508
  - Bandwidth ........................................ 509
  - So who are these folks we call users? .............. 510
  - Streaming ......................................... 510
  - The Bandwidth Profiler ............................. 512
  - Optimizing and fine-tuning your Flash movies .... 516
    - Structure ...................................... 516
    - Optimizing elements in the movie ............... 518
    - Using the Loader class to display images and SWFs ........................................ 520
  - Your turn: Creating a preloader ...................... 522
  - Optimizing Flash content for use in video ......... 527
  - What you’ve learned ................................ 532
Chapter 14: Publishing Flash Movies ........................................ 535
  Web formats ......................................................... 536
  Flash ................................................................. 537
  HTML ................................................................. 538
  Animated GIFs ..................................................... 539
  QuickTime ......................................................... 542
  It’s showtime! ...................................................... 543
  Publishing Flash movies containing linked files ..................... 553
  What you’ve learned ............................................. 555

Index .............................................................................. 556
FOREWORD

Like a lot of kids, I was entranced by animation. My childhood was littered with flipbooks, doodles, and at least one zoetrope I built from a kit. I even had an electronic toy called the Etch-a-Sketch Animator that let you create 12 black-and-white “pictures” on a 30×40-pixel screen and make them play back in sequence. This created possibly the worst animation ever, but to a 10-year-old it was the coolest thing!

This love for animation was lost for a few years, as I got deeper and deeper into computers. As I moved through high school and kept learning new operating systems and programming languages, I was starting to realize that one day working/playing with computers could be my career.

Then, in my sophomore year of college, I was introduced to Flash. All of the books I had read about Disney, Warner Brothers, and Hanna-Barbera came flooding back to me. With reckless abandon I learned everything I could about Flash—and was done after about a week. Flash wasn't exactly complicated in those days, and ActionScript didn't consist of much more than stop and play.

The good news was that I was in a perfect place for keeping pace with Flash as it grew—my programming background along with my love for animation let me keep on top of every new version of Flash as it was released. I was in the enviable position of being able to just ride the wave from version to version.

During that time, I spoke at and attended a lot of Flash conferences, where I was lucky enough to meet both Tom Green and David Stiller. If you’re ever in a room with Tom, you’ll know—the raucous laughter is your first clue. Tom has a real exuberance for learning, teaching, and life in general that is all too rare in this world. He is constantly striving to learn more and discover new ways to convey that knowledge to his students. As for David, he is from the true old school—a modern-day Renaissance man. He struck up a conversation with me about obscure board games a few years ago. The conversation wound its way through quantum mechanics, the proper brewing of Turkish coffee, and toy building, and technically is still going on today. I am proud to be able to call on him as a contractor for my company and even more proud to call him a friend.
Now, back to Flash. Recently, it has become such a huge product that I’m starting to see what folks who are new to Flash go through all over again—I’m starting to struggle a bit with the new versions. I don’t have the time to peek into each new cranny of the program. I can’t sit down and figure out all the new best practices. It’s pretty overwhelming.

That’s why I was very, very happy when I found out that Tom and David were working on this book—they have done all the research for me, so I’m not going to fall behind! I knew Tom and David would take Flash CS3 and distill everything about it into an informative and fun-to-read tome for newcomers and old hats like myself.

I’m very happy to tell you, they didn’t disappoint. Enjoy the firm binding and nice new look of your new book now because I’m sure it will become well loved, dog-eared, and covered in sticky notes in no time!

Branden Hall  
CTO—Automata Studios Ltd.  
June 2007
ABOUT THE AUTHORS

Tom Green is currently professor of interactive media in the School of Media Studies at Humber College Institute of Technology and Advanced Learning in Toronto, Canada. He has written seven previous books on Adobe technologies and many articles for numerous magazines and websites, including Community MX, Digital Web Magazine, and Computer Arts. He has spoken at over 20 conferences internationally, including Adobe Max, NAB, FITC, MX North, Digital Design World, TODCON, and SparkEurope. You can contact Tom at tom@tomontheweb.ca.

David Stiller is an independent contractor whose portfolio includes multimedia programming and design for NASA, DOT, Adobe, major US automotive and boat manufacturers, and dozens of clients across the US and Canada. David gets a kick out of sharing “aha!” moments with others through consultation, mentoring, and regular contributions to the Adobe Flash and ActionScript forums, his blog (http://quip.net/blog/), and articles for Community MX. In off hours, his interests include unicycling, anaglyph 3D photography, finely crafted wooden game boards, Library of Congress field recordings, and Turkish coffee. David lives in Virginia with his amazing wife, Dawn, and his beguiling daughter, Meridian.
ABOUT THE TECHNICAL REVIEWER

Adam Thomas’s career can best be defined as a successful hobby. Having an early interest in computers and being mostly self-taught, he decided to go to Humber College in Toronto to study computer information systems. Soon after his graduation in 2001, Adam was invited back to his school to be a professor of rich media and web development. Alongside teaching, he runs a successful web studio called Robin Hood Tech. Adam takes pride in employing former students who he has had the privilege of teaching and giving them the opportunity to gain experience and excel in a competitive field. Adam is cofounder of the Robin Hood Business Model, which advocates for justice in business. Adam strives for integrity and simplicity, but his true motivation is his wife and family, who are daily reminders of love, faith, and blessing.
ABOUT THE COVER IMAGE DESIGNER

Corné van Dooren designed the front cover image for this book. After taking a brief from friends of ED to create a new design for the Foundation series, he worked at combining technological and organic forms, with the results now appearing on this and other books’ covers.

Corné spent his childhood drawing on everything at hand and then began exploring the infinite world of multimedia—and his journey of discovery hasn’t stopped since. His mantra has always been “The only limit to multimedia is the imagination,” a saying that keeps him moving forward constantly.

Corné works for many international clients, writes features for multimedia magazines, reviews and tests software, authors multimedia studies, and works on many other friends of ED books. You can see more of his work at www.cornevandooren.com, as well as contact him through his website.

If you like Corné’s work, be sure to check out his chapter in New Masters of Photoshop: Volume 2 (friends of ED, 2004).
ACKNOWLEDGMENTS

Working with a coauthor can be a tricky business. In fact, it is a lot like a marriage. Everything is wonderful when things are going well, but you never really discover the strength of the relationship until you get deep into it. When I asked David if he would share the cover with me, his response was an immediate “Am I intrigued? Umm, schyaaaah!” From that point on, David and I worked together to produce this book. As we got deeper into the process, we discovered we had undergone some sort of weird “Vulcan mind-meld” where we each instinctively understood what the other was talking about and moved on from there. When David brought Peter Pan and the Tron Guy into the book, I just knew this was going to be a special project and that a rather precious writing and professional relationship, as well as deep friendship, was in place. I learned a lot from David, shared some great laughs, and the two of us produced something that went far beyond what we both envisioned. It looks like he and I are in for the long haul, and I couldn’t be happier.

As we dug into this book, we realized that we could tell you what to do, but the “names” in this business could reinforce, from personal experience, what we were telling you. We deeply appreciate the help we got from Jennifer Shiman, Kristen Henry, Chris Georgenes, John Kricfalusi, and David Schroeder for sharing their experiences and insights with you.

Next up is our editor, Chris Mills. This will be the third book I have written for him, and when I explained how I wanted to move outside of the usual way of doing a Foundation book, he thought about it for a millisecond and told me to go for it. Chris stayed out of the way but was always there when we got stuck and needed a kick in the pants or a “have you thought of this . . . ?” idea. Even though Chris and I have a solid, professional relationship, we have also become good friends.

Finally, writing a book means I hole myself up in my office and become generally moody and difficult to be around as I mull over a technique or try to identify why something isn’t quite working. It takes a very unique individual to live with that, let alone understand why—and my wife, best friend, and life partner over the past 30 years has somehow put up with it.

Tom Green
Tom’s the one who invited me on this tour bus, so I’d like to thank him right out the gate. From the beginning, we connected—zing!—on a heartfelt foundation of laughter, the kind you get from a good poke to the belly button. In fact, for months, I nicknamed our collaboration the “Tom and Jerry Show” (I was born in Germany, which makes me the Jerry. . . Tom, he’s the big gray pussy cat, obviously). Humor carried us through a number of zany tribulations, including combustible early beta software and even puffs of smoke (literally) on various computers at our disposal. Humor inspired us in our analogies and illustrations, and humor kept my paws inches ahead of Tom as he chased me around the kitchen, again and again, with a cleaver (he’ll never catch me)! I couldn’t have asked for a better swim buddy. Thanks again, Green!

Over the years, I’ve learned quite a bit about programming and life in general from a dear friend who both exists and does not, and who goes by the name Uncle Chutney. “Big things are made up of lots of little things,” he keeps telling me, and he’s right. That proverb has gotten me out of many a jam.

Numerous people helped us write this book, from engineers at Adobe and partners at Community MX (especially Joseph Balderson and Steven Schelter) to friends ready at a moment’s notice to test this-and-that, lend a pair of ears, or simply laugh (or not) at a pun. For me that list includes Noah DiCenso, Chris Georgenes, Branden Hall, Bruce Hartman, Ted Johns, Keenan Keeling, Rich Lee, Ernie Lindsey, Adam Oldham, Rothrock, Todd Sanders, and especially Amy Niebel, who often kept my head screwed on and my chin up. Thanks to Randy Constan and Jay Maynard for being so cool. Thanks, John K., for the yuks!

Near the end of this book, my wife made our backyard magical by planting a garden in it with our daughter. As always, I saw Dawn transform everyday banalities into learning opportunities for Meridian. I saw my daughter grow because of it. When I can teach as well as Dawn does, I’ll be getting somewhere. These are my favorite two people in the world, and I owe them—big time—for their patience while I was writing. Na, Bohn, jetzt ist Papi endlich fertig. Was wollen wir nun spielen?

David Stiller
INTRODUCTION

I can remember the day as clear is if it were just yesterday. I was walking by my boss' office late one winter afternoon at the college where I teach, and he called me into his office. Sitting on his desk was a thin white box with some sort of weird swirl on it. He slid the box across to me and asked, “You know anything about Flash?”

To be honest, as a Director user, what I knew was filtered through the eyes of a Director guy, which meant I didn’t know much and what I did know convinced me it was a wind-up toy compared to Director. I replied, “A bit.” The boss leaned back in his chair and said, “Well learn a lot more because you are teaching it in four weeks.” This was the start of one of the longest, strangest, and most exhilarating trips I have ever been on. The version was Flash 3, and I have been using and teaching Flash ever since.

In many respects, Flash CS3 completes the process started by Macromedia, now Adobe, with the release of Flash 8. That release was a “designer” release, meaning there were lots of goodies for the creatives and a few for the coders. This iteration of the application is the “developer” release. The coders are dancing in the streets, and the creatives are wondering what the hell happened.

In many respects, this release of the application marks the absorption of Flash into the Adobe product line, and Adobe didn’t just toss it on the pile. As you will discover, there are some seriously cool new features that allow Flash users to take advantage of new workflows among all of the applications in the Adobe lineup including Photoshop CS3, Illustrator CS3, Fireworks CS3, Dreamweaver CS3, and even After Effects CS3 and Soundbooth CS3. The big news, of course, is the introduction of ActionScript 3.0.

This revision of the Flash scripting language will initially, in the immortal words of Ed Grimley, “Drive you mental!” The key word is “initially,” because once you get used to it, you will discover everything you know about ActionScript still applies . . . just a bit differently. When Dave and I started mapping out this book, we decided to go with ActionScript 3.0 for every line of code in the book. In this way, you can learn the fundamentals and use them as a jumping-off point to further explore the power of this language.

This book is also a bit different from any Flash book you may have read or considered purchasing. From the very start of the process, Dave and I put ourselves in your shoes and asked a simple question: “What do you need to know and why?” This question led us into territory
that we didn’t quite expect. As we were grappling with that question early in the process, we kept bothering our network of Flash friends to be sure we were on the right track. At some point, both of us simultaneously came to the conclusion, “Why not just let them explain it in their own words?” This is why, as you journey through this book, you will encounter various experts in the field telling you why they do things and offering you insights into what they have learned. The odd thing is, at some point in their careers, they were no different from you.

One other aspect of this book that we feel is important is we had a lot of fun developing the examples and exercises in the book. The fun aspect is important because if learning is fun, what you learn will be retained. Anybody can show you how to apply a Glow filter to a line on the Flash stage. It is more effective when you do exactly the same thing to a guy wearing a Tron suit. Anybody can dryly explain 9-slice scaling, but it becomes less techie when you apply it to a guy dressed as Peter Pan. Nested movieclips are a “yawner” at best, but when they are related to a Hostess Twinkie, the concept becomes understandable. Shared libraries are an important subject. Instead of filling a library with circles and text, the concept becomes relevant when the library is populated with “Bunny Bits.”

As you may have guessed, we continue to exhibit a sense of joy and wonder with Flash, and we hope a little bit of our enthusiasm rubs off on you as well.

**Book structure and flow**

To start, this is not a typical *Foundation* book. There is no common project that runs throughout the book. Instead, each chapter contains a number of exercises to help you develop some “Flash chops,” and then we turn you loose in the “Your turn” section of each chapter.

We start by dropping you right into the application and creating a small Flash movie we call “Moonrise Over Lake Nanagook” (told you we were having fun). This chapter familiarizes you with the Flash workspace and the fundamentals of using Flash Professional CS3. Chapter 2 introduces you to working with the graphic tools and with graphics files and finishes with your creating a Monty Python–style banner ad.

Chapter 3 introduces you to symbols and libraries in Flash CS3. In this chapter, you learn how to create and use symbols, and we even let Peter Pan explain how 9-slice scaling works. With those fundamentals under your belt, we show you how to share symbols and libraries between movies, how to manipulate symbols with filters and blend effects, and along the way you travel from the Beijing Zoo to Times Square, discovering how to create some rather powerful effects in your Flash movies. The chapter finishes by showing you how to use masks to your advantage in Flash.

At this point in the book, you have pretty well mastered the fundamentals. The rest of the book builds upon what you have learned. Chapter 4 picks you up and throws you into the ActionScript 3.0 pool. Chapter 5 starts by explaining how to use audio in Flash and finishes with your constructing an MP3 player.
Chapter 6 reinforces the message that “text isn’t the gray stuff that surrounds your animations.” We show you how it is both serious and fun by stepping through how to create scrolling text and how to blow up your name. Chapter 7 is one of the more important chapters in the book because Flash’s roots were as an animation application. You are going to learn the basics here, but don’t expect to be shoving boxes and circles around. You will be banging hammers, eating apples, dropping parrots, putting on a Tron suit and lighting it up, and setting a butterfly in motion. Did we mention we believe in having fun?

From animation we move into video in Flash. In Chapter 8, we show the entire process from encoding to upload. In fact, the chapter finishes with your adding captions and a full-screen capability to a Superman movie. Along the way, you will visit heaven and also meet a rather neurotic cartoon character.

Chapters 9, 10, and 11 give you the chance to play with all of the Flash user interface components, actually style a Flash movie using Cascading Style Sheets, and explore how XML gives you a huge amount of flexibility when it comes to adding dynamic data to your movie.

Chapter 12 moves you out of Flash and into the mobile space. Device Central is a new addition to the CS3 lineup, and here you will be creating a slideshow that will appear on a cell phone.

The final two chapters focus on the end game of the design process. Chapter 13 shows you a number of the important techniques you need to know that will keep your movies small and efficient. Chapter 14 shows you how to create the SWF that will be embedded into a web page and how to keep that process as smooth as possible.

Finally, David and I are no different from you. We are learning about this application and what it can and cannot do at the same time as you. Though we may be coming at it from a slightly more advanced level, there is a lot about this application we’re still learning. If there is something we have missed or something you don’t quite understand, by all means contact us. We’ll be sure to add it to the book’s site. Our final words of advice for you are:

*The amount of fun you can have with this application should be illegal. We’ll see you in jail!*

Tom Green
Layout conventions

To keep this book as clear and easy to follow as possible, the following text conventions are used throughout.

Important words or concepts are normally highlighted on the first appearance in **bold type**.

Code is presented in **fixed-width font**.

New or changed code is normally presented in **bold fixed-width font**.

Pseudo-code and variable input are written in *italic fixed-width font*.

Menu commands are written in the form Menu ➤ Submenu ➤ Submenu.

Where we want to draw your attention to something, we've highlighted it like this:

Ahem, don’t say we didn’t warn you.

Sometimes code won’t fit on a single line in a book. Where this happens, we use an arrow like this: ➤.

This is a very, very long section of code that should be written all ➤ on the same line without a break.
1 LEARNING THE FLASH CS3 PROFESSIONAL INTERFACE
Welcome to Flash CS3 Professional. We suspect you are here because you have seen a lot of the great stuff Flash can do and it is now time for you to get into the game. We also suspect you are here because Flash can be one great big, scary application to those unfamiliar with it. The other reason you may be here is because you are an existing Flash user and CS3 is suddenly a lot different from Flash MX 2004 or Flash 8, and you need to get yourself trained up on the new stuff in relatively short order. In either case, both of the authors have been in your shoes at some point in our careers, which means we understand what you are feeling. So instead of jumping right into the application . . . let’s go for walk.

What we’ll cover in this chapter:

- Exploring the Flash interface
- Using the Flash stage
- Working with panels
- The difference between a frame and a keyframe
- Using frames to arrange content on the stage
- Using layers to manage content on the stage
- Adding objects to the library
- Testing your movie

Files used in this chapter:

- Ball.fla (Chapter01/ExerciseFiles_CH01/Exercise/Ball.fla)
- Properties.fla (Chapter01/ExerciseFiles_CH01/Exercise/Properties.fla)
- Layers.fla (Chapter01/ExerciseFiles_CH01/Exercise/Layers.fla)
- MoonOverLakeNanagook.fla (Chapter01/ExerciseFiles_CH01/Exercise/MoonOverLakeNanagook.fla)
- Nanagook.mp3 (Chapter01/ExerciseFiles_CH01/Exercise/Nanagook.mp3)

What we are going to do in this chapter is take a walk through the authoring environment—called the Flash interface—pointing out the sights and giving you an opportunity to play with the features. By the end of the stroll, you should be fairly comfortable with this tool called Flash and have a fairly good idea of what tools you can use and how to use them as you start creating a Flash movie.

As we go for our walk, we will also be having a conversation that will help you to understand the fundamentals of the creation of a Flash movie. Having this knowledge right at the start of the process gives you the confidence to build upon what you have learned. So let’s start right at the beginning of the process . . . the Start page.

The Start page and creating a Flash document

The first thing you see when you launch Flash is the Start page shown in Figure 1-1. This interface, common to all of the Adobe CS3 applications, is divided into three areas. The area on the left side shows you a list of documents you have previously opened. Click one
of them, and that document, provided it hasn’t been moved to another location on your computer, will open. The Open link at the bottom of the list lets you navigate to a document that isn’t on the list.

![Figure 1-1. The Start page](image)

The middle area of the page is where you can choose to create a variety of new Flash documents. Your choices include a blank Flash document, a project aimed at a cell phone or PDA (a mobile document), a series of code-based documents, and a Flash project.

The major change in this panel is the ability to select a new document based upon which version of ActionScript will be used in the document. Flash Professional CS3 marks the latest version of the Flash programming language named ActionScript. The previous version of this language, used in Flash MX 2004 and Flash 8, was ActionScript 2.0. We will be digging into ActionScript 3.0 in greater depth in Chapter 4.

*From this point on, unless otherwise stated, you will be selecting the Flash File (ActionScript 3.0) option when opening new documents throughout this book.*

The right area of the page is reserved for a variety of templates you can use. Clicking one of the folders opens the New from Template dialog box, as shown in Figure 1-2. The Extend area at the bottom of this column contains a link to the Flash Exchange. This is a hyperlink that takes you to a page on the Adobe site where you can download a variety of tools and projects that are available for free or a nominal cost. Let’s open a new document. Simply click Flash File (ActionScript 3.0) in the Create New area of the Start page to open the Flash interface.
Figure 1-2. Flash contains a variety of templates designed to help you become more productive.

The interface that opens is the feature-rich authoring environment (shown in Figure 1-3) that is the heart and soul of Flash. If you are an existing Flash user, the first thing that will catch your attention is that the interface looks somewhat different from previous versions of the application.

Figure 1-3. The Flash authoring environment
The **stage**, the large white area in the center of the screen, is where the action happens. A good way of regarding the stage in relation to Flash is this: if it isn’t on the stage, the user isn’t going to see it. There will be instances where this last statement is not exactly true, but we’ll get into those later on in this book. On the left side of the screen is a set of tools that will allow you to draw, color, and otherwise manipulate objects on the stage. At the bottom of the interface is the Property inspector. We’ll talk about this a little later on, but as you become more comfortable with the application, this panel will become a very important place for you.

At the top of the interface is the **timeline**. This is the place where action occurs. As you can see, the timeline is broken into a series of boxes called **frames**. The best way of regarding frames is as individual frames of a film. When you put something on the stage, it will appear in a frame. If you want it to move from here to there, it will start in one frame and end in another a little further along the timeline. That red box you see in frame 1 is called the **playhead**. Its purpose is to show you the current frame being displayed. When a Flash movie is playing through a browser, the playhead is in motion and the user is seeing the frame where the playhead is located. This is how things appear to move in Flash.

Another thing you can do with the playhead is drag it across the timeline while you are creating the Flash movie. This technique is known as **scrubbing** the timeline, and has its roots in film editing.

On the right side of the interface are the panels. Panels are used to modify and manipulate whatever object you may have selected on the stage or to even add an object to the stage. These objects can be text, photographs, line art, short animations, video, or even interface elements called components. You can use the panels and the menus to change not only the characteristics of the objects, but also how the objects behave on the stage. Panels can be connected to each other (docked) or they can float freely in the interface (floating).

**Managing your workspace**

As you may have surmised, the Flash authoring environment is one busy place, and if you talk to a Flash developer or designer, he will also tell you it can become one crowded place as well. As you start creating Flash projects, you will discover that real estate on your screen is a valuable commodity as it fills up with floating panels and other elements. This has all changed in Flash CS3. Here’s how you manage the panels:

- At the top of the **Tools** panel and the Panels area on the right side of the screen is an icon that looks like a double arrow (see Figure 1-4). Click it and the panels will collapse and become icons. If you click the arrow above the tools, the **Tools** panel expands from a strip to a two-column layout. The process is called **panel collapse**, and is designed to free up screen space in Flash. In fact, Adobe is so thrilled with this feature that you can expect to see it added to all of the applications in the CS Studio over the next couple of years.

- Place the cursor over the bottom icon on the panel strip. The icon will change from gray to color, and a tooltip telling you what the item is will appear.
With the panel collapsed, place the cursor to the left of the icons in the panel strip. When the cursor changes to a double arrow, drag the panel strip to the left or to the right. As you drag to the left, the panel icons will expand and show you the name of the panel. As you drag to the right, the names will disappear and only the icon will be visible.

With the panel collapsed, click an icon in the strip and the contents of that panel will fly out (as shown in Figure 1-5). Click it again and the contents of the panel will slide back. These panels that fly out and slide in are called drawers.

Another method of buying some screen real estate is to collapse a panel by minimizing it. With the panel opened, click the - sign in the upper-right corner of the Property inspector or on the gray bar itself, and it will collapse and only show you the tabs. Click it again and the panel will grow to its original dimensions.

Here's a little trick that is new to the Property inspector. See that little dot beside the word Properties? Click it, and the panel will be reduced to half size. Click it again, and the panel will collapse to just show the tabs. Click it again, and the panel will expand back to full size.

Click the Close button—the X—in a panel, and the panel will be removed from the group. If you do remove a panel, all is not lost. Open the Window menu and click the name of the panel you closed to restore it.

Drag one of the panel icons onto another panel. When you release the mouse, the panel will expand to include the new panel added. This is called a panel set. To remove a panel from a set, just drag the panel icon to the bottom of the stack.

Though not a technique, this tip falls squarely into the “well, it’s about time” category of new stuff. If you drag a floating panel over another interface element, the floating panel will become somewhat transparent and let you see what is under the panel.

Now that you have learned to become the master of the work environment, let’s take a look at how you can also become the master of your Flash document.
Setting document preferences and properties

Managing the workspace is a fundamental skill, but the most important decision you will make concerns the size of the Flash stage and the space it will take up in the browser. That decision is based upon a number of factors, including the type of content to be displayed and the other items that will appear in the HTML document. These decisions all affect the stage size and, in many respects, the way the document is handled by Flash. These two factors are managed by the Preferences panel and the Document Properties dialog box.

To access the Preferences panel, select Edit ➤ Preferences (PC) or Flash Professional ➤ Preferences (Mac). There is a lot to this panel, and we’ll explore it further at various points throughout this book. For now, we are concerned with the general preferences in the Category area of the window. Click General and the window will change to show you the general preferences for Flash (see Figure 1-6).

![Preferences Panel](image)

**Figure 1-6.** The general preferences can be used to manage not only the workspace but also items on the stage.

If you examine many of the selections, you will realize they are fairly intuitive. You can choose to see the Start page when the application starts, to see tooltips when the cursor is over a tool or object, to have a test movie appear in a tabbed window or float, how items
are selected on the stage and the timeline, and even the colors that will be used to tell you what type of object has been selected on the stage. Now that you know how to set your preferences, let’s look at managing the document properties. Follow these steps:

![If you have been using Flash for a few years, you’ll find that the expansion of the Highlight color list to include a variety of objects is a welcome addition.](image)

1. Click the Cancel button to close the window and return to the Flash interface.
2. Click the Size button on the Property inspector. This will open the Document Properties dialog box (shown in Figure 1-7). Other methods of opening this dialog box are as follows:
   - Select Modify ➤ Document.
   - Press Ctrl+J (PC) or Cmd+J (Mac).
   - Right-click (PC) or Ctrl-click (Mac) and select Document Properties from the context menu.
   - Double-click the box that shows 12 fps under the timeline.

![As you have just seen, there a number of methods you can use in Flash to obtain the same result. In this case, it is opening the Document Properties dialog box. Which one is best? The answer is simple: whichever one you choose.](image)

![Figure 1-7. Set the stage size through the Document Properties dialog box.](image)